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Question No: 1 (Marks: 1) -Please choose one
Human are better than computers at:
» Efficiency P Accuracy W Pattern recognitio » None of the given choices

Question No: 2 (Marks: 1) -Please choose one
Cray-1 was first commercial computer
» Super » Mini » Micro » Personal

Question No: 3 (Marks: 1) -Please choose one
URL is a/an
» Device » Component » Address » Tool

Question No: 4 (Marks: 1) -Please choose one

Mainframe Computers are also called
» Enterprise Servers » Personal Servers » Enterprise Managers  » Window Servers

Question No: 5 (Marks: 1) -Please choose one
Which of the following is NOT a category of Mobile Computers?
» Laptop » Palmtop > Desktop » Wearable

Question No: 6 (Marks: 1) -Please choose one
Preliminary exploration of possible solutions, technologies, suppliers is called
» Viability » Feasibility » Specification » Integration

Question No: 7 (Marks: 1) -Please choose one
give us the ability to manipulate data through reference instead of actual value.
» Constants » Variables » Data Types » Operators

Question No: 8 (Marks: 1) -Please choose one
Consider the following statement written in JavaScript:
str = "Hello” + ” World”
What will be the value of str ?
» HelloWorid » Hello World » Hello + World » It will result in error

Question No: 9 (Marks: 1) -Please choose one
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A tool that helps you to find the synonyms is called .
» Language » Paragraph » Thesaurus » Symbol

Question No: 10 (Marks: 1) -Please choose one
Communication protocol is a that governs the flow of information over a network
» Set of protocols » Set of rules » Device » Set of methods

Question No: 11 (Marks: 1) -Please choose one
If a computer could pass the Turing test then it would be able to:
» think like human beings
» do the things faster
» win a million dollar prize
» store more information

Question No: 12 (Marks: 1) -Please choose one
The first Web browser with a GUI was generally available in:
> 1992 > 1993 > 1994 » 1995

Question No: 13 (Marks: 1) -Please choose one
Web is a unique invention by humans in terms that it is:
» accessible to only the owners who control it

» accessible from particular locations only
» accessible to all humans
» accessible to only the educational institutes

Question No: 14 (Marks: 1) -Please choose one
In this URL http://www.msn.com , identifies the domain name
» http > www » msn » com

Question No: 15 (Marks: 1) - Please choose one
is simply a fast port that lets you connect computer peripherals and consumer electronics to
your computer without restart.
» Freeware » Shareware » Firewire » Firmware

Question No: 16 ( Marks: 1) -Please choose one

Which of the following is NOT supported by PC's power supply.
» -12and +12 V DC » -10 and +10 V DC » -5and+5VDC » All are supported

Question No: 17 (Marks: 1) -Please choose one
In which case Cache Memory is used
P To increase RAM speed
» To overcome BUS speed
» To overcome Speed rate between RAM and CPU
» To overcome CPU speed

Question No: 18 (Marks: 1) -Please choose one
To display a single line text area on the web page, we use tag
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» TEXT » TEXTBOX > INPUT » INPUTBOX

Question No: 19 (Marks: 1) -Please choose one
If an algorithm is syntactically correct, but semantically incorrect then this situation is
» Very good situation
» Very dangerous situation
» Not very bad
» Neutral situation

Question No: 20 (Marks: 1) -Please choose one
Users communicate with the computer using a consistent user interface provided by the OS.
> True » False

Question No: 21 (Marks: 1) -Please choose one
Application developers do not need to know much about the HW, especially the microProcessor, while they are
developing their application.

> True » False

Question No: 22 (Marks: 1) -Please choose one

The first spread sheet program was invented by
» Charles Babbage » Dan Bricklin » Paul Graham » John von Neumann

Question No: 23 (Marks: 1) -Please choose one
Which representation technique of algorithm is more suitable for developer to make actual

code .
» pseudo code P flow chart P both pseudo code and flow chart » Heuristics

Question No: 24 (Marks: 1) -Please choose one
is used to terminate all JavaScript statements.
» Colon » Semicolon » Underscore » Apostrophe

Question No: 25 (Marks: 1) -Please choose one
In java script cookies can be created for future use
» Easily
» No facility at all
» This is not possible without Java language.
» Cookies are files so java script can not handle it.

Question No: 26 ( Marks: 1) -Please choose one
When the microprocessor desires to look at a piece of data, it checks in the first.
» RAM » ROM » hard disk » cache
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Question No: 1 (Marks: 1) - Please choose one
Using Java Script you can write a character at random location on screen
» By applying randomCh() method
» With the help of String object
» With the help of random character property
» There is no built in approach in Java Script

Question No: 2 (Marks: 1) - Please choose one
If incorrectly we enter the negative age it is check by
» Limit Integrity » Type Integrity P Referential Integrity P> Physical Integrity

Question No: 3 (Marks: 1) - Please choose one
The Encryption of data is related to
» Data updates » Data security » Data integrity P Data accessibility

Question No: 4 (Marks: 1) - Please choose one
Which protocol is use to transfer a file over the network ?
» UDP > FTP » TCP » OSI

Question No: 5 (Marks: 1) - Please choose one
One can send an email message to a remote computer using protocol
» HTTP » SMTP » FTP » TELNET

Question No: 6 (Marks: 1) - Please choose one
In a System having many parts to be designed, one should always do the first
» Hard part » Simple part » Development part » Quality part

Question No: 7 (Marks: 1) - Please choose one
Flow control constructs in JavaScript includes:
» If-Else » Loops and If -Else » Switch and If-Else » All of the given choices

Question No: 8 (Marks: 1) - Please choose one
____provides a simple, consistent way for applications to interact with the HW without having to know all the
details of the HW

» Explorer.exe P System Files P Operating System  Application Software

Question No: 9 (Marks: 1) - Please choose one
Machine language is also called
» Assembly Language » Binary Language » High Level Language » HTML Language

Question No: 10 (Marks: 1) - Please choose one
is the best known builder for supercomputers.
» Sun » Cray Research » Microsoft » Apple
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Question No: 11 ( Marks: 1) - Please choose one
The weaknesses of the computer are:

» Pattern recognition & Storage

» Speed & Innovative ideas

> Pattern recognition & Innovative ideas

» Speed & Storage

Question No: 12 ( Marks: 1) - Please choose one
Communication protocol is a that governs the flow of information over a network
» Set of methods » Set of protocols > Set of rules » Device

Question No: 13 (Marks: 1) - Please choose one

team is responsible for the maintenance, expansion , improvement of the infrastructure
consisting of workstations, networking equipment, software and network security.

» Support P Configuration Management P Quality Assurance P Developer

Question No: 14 (Marks: 1) - Please choose one
team consists on the sharpest technical minds in the company.
» Architecture P Business Development P> Configuration Management P Developer

Question No: 15 (Marks: 1) - Please choose one
is responsible for day to day operations.
» CEO » COO » CMSO » Developer

Question No: 16 (Marks: 1) - Please choose one
One of the key responsibilities of the is client relationship management.
» Project Manager P Team Lead ® Developer P Quality Assurance Engineer

Question No: 17 (Marks: 1) - Please choose one
What is the major problem with flash based website?
» Its two heavy » Cannot be indexed » Less attractive P> Inaccessible

Question No: 18 ( Marks: 1) - Please choose one
Which of the following is NOT an event handler for image object?
» onAbort » onError » onLoad » onUser

Question No: 19 ( Marks: 1) - Please choose one
The organizations are learning that business can be done in a more effective manner if emphasis is placed upon

B Cooperation » Shared responsibility P Networking P All of the given options

Question No: 1 (Marks: 1) - Please choose one

It represents the flow chart element.
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» Flow Line » Connector » Oftf-page connector » Start or Stop

Question No: 2 (Marks: 1) - Please choose one

What is NOT a key
factor while designing a website?
» Usability » User-friendly » Consistency » Complexity
Question No: 3 (Marks: 1) - Please choose one
% of the

users have left websites in frustration due to poor navigation.
»40 P62 P8 P Il

Question No: 4 (Marks: 1) - Please choose one
In JavaScript, a

variable declaration is
> Optional » Mandatory » Not allowed » None of the given

Question No: 5 (Marks: 1) - Please choose one
A protocol used for

receiving email messages is called .
» URL » Telnet » POP3 » SMTP

Question No: 6 (Marks: 1) - Please choose one
Which is correct?

» onUnload » onUnLoad » onUNLOAD » All of the above

Question No: 7 (Marks: 1) - Please choose one

Serial arrangement
in which things follow logical order or a recurrent pattern, such as statements executing one by one, is called

» Loop » Sequence » Condition » Array

Question No: 8 (Marks: 1) - Please choose one
Variables allow us to

manipulate data through the .
» Actual Value » Reference » Length » Name

Question No: 9 (Marks: 1) - Please choose one

Fuzzy logic 1s based
on

» Ground facts » Experience » Practice » Approximation

Question No: 10 (Marks: 1) - Please choose one
Word Processor is a
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» System Software » Application Software » Device » Utility

Question No: 11 (Marks: 1) - Please choose one
In the old days,

databases did NOT support .
» Number » Boolean » Video » Text

Question No: 12 (Marks: 1) - Please choose one
In tabular storage,

fields placed in a particular row are strongly .
» Independent » Dependent » Interrelated » Inconsistent

Question No: 13 (Marks: 1) - Please choose one
Due to working at

home, lack of interaction may result in professional growth.
» Slower » Faster » Higher » Improved

Question No: 14 (Marks: 1) - Please choose one
Distance learning

has got a boost due to the .
» Easy communication » Online interactive contents » Flexibility
> All of the given options

Question No: 15 (Marks: 1) - Please choose one

technique can be used to create smooth animations or to display one of several images based on the requirement.
» Image downloading » Image preloading » Image uploading
» Image postloading

Question No: 16 (Marks: 1) - Please choose one
The

is becoming the preferred organizational structure for more and more organizations with the passage of time.
» Tree structured organizational model
» Network paradigm P Hierarchical structure » None of the given options

Question No: 17 (Marks: 1) - Please choose one
The group of
technologies concerned with the capturing, processing and transmission of information in the digital electronic
form is called

» Telecom Engineering

» Computer Engineering

» Computer Science

» Information Technology
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Question No: 18 (Marks: 1) - Please choose one
A large number of

networks interconnected physically are called
> LAN » MAN » Internet » Network collection

Question No: 19 (Marks: 1) - Please choose one
TCP stands for

» Transfer Center protocol » Transmission Control Protocol
» Transmission Center Protocol » Telephone Center Protocol

Question No: 20 (Marks: 1) - Please choose one
A collection of data
organized in such a way that the computer can quickly search for a desired data item is known as:

» Retrieving > Database » Information » DBMS

Question No: 21 (Marks: 1) - Please choose one

is simply a

fast port that lets you connect computer peripherals and consumer electronics to your computer without restart.
» Freeware » Shareware » Firewire » Firmware

Question No: 22 (Marks: 1) - Please choose one
Structures, in which

another list starts before the first list is finished, are called:
» Multiple Lists P> Nested Lists » Ordered Lists P Un-ordered Lists

Question No: 23 (Marks: 1) - Please choose one

The key property of
the ‘Array’ object in JavaScript is
» Value » Length » Name » All of the given choices
Question No: 24 (Marks: 1) - Please choose one
Which one is the
example of spreadsheet software?
» MS Word » MS PowerPoint » MS Excel » MS Access
Question No: 25 (Marks: 1) - Please choose one
The Encryption of

data is related to
» Data updates P> Data security P Data integrity P Data accessibility

Question No: 26 (Marks: 1) - Please choose one

is the process

of analyzing large databases to identify patterns.
P Data normalization » Data management P Data Mining P None of the given options
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Question No: 27 (Marks: 1) - Please choose one

Which is the user-
friendly way of presenting data?
» Query » Form » Report » All of the given options

Question No: 28 (Marks: 1) - Please choose one
JavaScript function

fixed () has equivalent HTML tag-set
> <FIX>............... </FIX> P <F>............ </F>
» <PRE>............. </PRE> > <H>.........o.o </H>

Question No: 29 (Marks: 1) - Please choose one
<Form> Tags always

placed between the <BODY> and </BODY> tags of a Web page
> True
» False

Question No: 30 (Marks: 1) - Please choose one
Java script has -------

---------- ability to create and draw graphics.

» Limited » Versatile » Medium » Not at all

Final term paper

1-when actions depends upon the values of multiple variables we 11 use -----?
1-if 2-else 3-if--—-else  4-none

2-when the exact number of iterations is known use the ----loop ?
1-for 2-if 3-while 4-none

3-when the number of iteration depend upon a condition being met use the ------ loop
1-for 2-switch 3-while 4-none

4-the key property of “array “object is ----------- ?
1-length 2-width 3-single 4-none

5-two of the key “array “methods are reverse ()-sort()
1-true 2-false




6-javascript array are -------?
1-multiple 2-herterogenous 3-homogenous 4-none

7------multiple computer that are connected together to share information and other
resources
1-network 2-internets 3-compnetworks 4-none

8 - comp networks can send an email message to a remote comp using the ----

protocol?
1-HTTP 2-FIP 3-SMTP 4-none

9-comp network can browse documents residing on a remote comp using ------- ?
1-HTTP 2-FTP 3-SMTP 4-none

10-comp networks can download and upload files to a remote comp using ------?
1-HTTP 2-FTP 3-SMTP 4-none

11- network can run a program on remote comp using the ------------2?
1-SMTP 2-TELNET 3-HTTP 4-none

12-components of convertional computer networks are except one ?
1-VPN 2-NIC 3-computers 4-hub

13-NIC stands for ------------?
1-national internet cables 2-national interface cards
3-network interface cards 4-none

14-cables are either------------ ?
1-electrical 2-digita 13-optical 4-1 and 2

15- hub component of comp network is ------------ ?
1-I/O device  2-traffic controller
3-network traffic controller  4-none

16- optical cables are required by wireless networks
1-true 2-false
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17------ a deviece used to connect several computer to form a network

1-hub 2-cable 3-NIC 4-none

18- a hub has several ----- ?
1-NIC 2-cables 3-packet 4-ports

19- ------ smaller unit of data transmitted over a comp network
1-hub 2-port 3-packet 4-none

20- all packets travel---------- ?
1-dependently 2-independently 3-alternatively 4-none

Question No: 1 (Marks: 1) - Please choose one
---------- was known as “mill” in Analytical engine.
» Memory » Processor » Monitor » Mouse

Question No: 2 (Marks: 1) - Please choose one
First electronic computer was
> ABC » UNVAC1 » Harvard Mark 1 » IBM PC

Question No: 3 (Marks: 1) - Please choose one
What is NOT a key factor while designing a website?
» Usability » User-friendly P Consistency » Complexity

Question No: 4 (Marks: 1) - Please choose one
What happens if I start a new list without closing the original one?
» An error will be generated > A nested list will be created
» Previous list will end and a new will start. » Nothing will happen

Question No: 5 ( Marks: 1) - Please choose one
The most upper right pixel of the screen is of color.
> Any > Red » Green » Blue

Question No: 6 (Marks: 1) - Please choose one
A single pixel can acquire approximately color schemes.
» 1 million » 2 million » 10 million » 16 million

Question No: 7 (Marks: 1) - Please choose one
The idea of Neural Networks field is based upon




» Human nature » Human brain » Human culture » Human actions

Question No: 8 (Marks: 1) - Please choose one
Which one of the following is an application for artificial intelligence?
» Robotic » Web Agent » Decision Support System P> All of the given options

Question No: 9 (Marks: 1) - Please choose one
Register is a kind of memory
» Fast » Super fast » Slow » Very slow

Question No: 10 ( Marks: 1) - Please choose one
Which of the following is a true statement?
» Flat-file storage is better than tabular storage.
» Tabular storage is better than flat-file storage.
» Flat-file storage is better than relational storage.
» None of the given options

Question No: 11 (Marks: 1) - Please choose one
substring(n, m) returns a string containing characters copied from position n to
» m-2 > m-1 » m+1 > m

Question No: 12 (Marks: 1) - Please choose one
The is the old profession which is being eliminated because of computing.
» Typist » Bank manager » Operational manager P All of the given options

Question No: 13 (Marks: 1) - Please choose one
The system that manages relational database, is called
» None of the given options
» Database Management System
» Data Management System
» Relational Database Management System

Question No: 14 ( Marks: 1) - Please choose one
When web server is busy it gives the following message to the user :
» Time out » Waiting P Server busy P None of the given options

Question No: 15 ( Marks: 1) - Please choose one
The group of technologies concerned with the capturing, processing and transmission of information in the digital
electronic form is called .

» Telecom Engineering » Computer Engineering

B Computer Science » Information Technology

Question No: 16 ( Marks: 1) - Please choose one
team consists on the sharpest technical minds in the company.
» Architecture » Business Development » Configuration Management P Developer
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Question No: 17 (Marks: 1) - Please choose one

TCP stands for .
» Transfer Center protocol » Transmission Control Protocol
» Transmission Center Protocol » Telephone Center Protocol

Question No: 18 ( Marks: 1) - Please choose one
A collection of data organized in such a way that the computer can quickly search for a desired data item is
known as :

» Retrieving > Database » Information » DBMS

Question No: 19 (Marks: 1) - Please choose one
Microsoft Word is a type of:
» System Software P Freeware Software » Shrink-Wrapped Software B> Custom-built Software

Question No: 20 ( Marks: 1) - Please choose one
Users , how things work.
» Analyze in detail » Muddle through » Figure out P Read in detail

Question No: 21 (Marks: 1) - Please choose one
Popular schemes used for reducing bytes for storage are:
» RGB and Color mapping » RGB and Dithering
» RGB, Color mapping and Dithering » Color mapping and Dithering

Question No: 22 (Marks: 1) - Please choose one
Hardware malfunctions is related to
» Data updates » Data integrity P Data security » Data accessibility

Question No: 23 (Marks: 1) - Please choose one
If incorrectly we enter the negative age it is check by
» Limit Integrity » Type Integrity » Referential Integrity P Physical Integrity

Question No: 24 (Marks: 1) - Please choose one
Which is the user-friendly way of presenting data ?
» Query » Form » Report » All of the given options

Question No: 25 ( Marks: 1) - Please choose one
Currently the BlueRay DVD can store more than of data.
» 10GB » 100 GB > 50 GB » 150 GB

Question No: 26 (Marks: 1) - Please choose one
In JavaScript, a||b is interpreted as

P ais true or b is false » ais true and b is true
P ais false and b is true P ais true or b is true or both are true

Question No: 27 (Marks: 1) - Please choose one
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Speakers fall into the hardware category.
» True » False

Question No: 28 ( Marks: 1) - Please choose one
onBlur event is occurred for a form element when it

» Gets focus » Losts focus » Some thing is typed in P onBlur is not an event

Question No: 29 (Marks: 1) - Please choose one
You can view a 3-D image on a
» 3-D display » 2-D display » On both 2-D and 3-D displays » We can not view a 3-D image

Question No: 30 ( Marks: 1) - Please choose one
Module level design and unit testing is the responsibility of
» Team Lead » Developer P Project Manager P Quality Assurance Expert

FINALTERM EXAMINATION
CS101- Introduction to Computing (Session - 2)
Question No: 1 ( Marks: 1) - Please choose one
What is NOT a key factor while designing a website?
» Usability » User-friendly » Consistency » Complexity

Question No: 2 ( Marks: 1) - Please choose one
Communications on the internet is controlled by a set of two protocols which are

» IMAP and SMTP » FTP and HTTP » TCP and IP » TCP and HTTP

Question No: 3 ( Marks: 1) - Please choose one
A variable can be in scope.
» Local » Global » Either local or global
» None of the given options

Question No: 4 ( Marks: 1) - Please choose one
A protocol used for receiving email messages is called
» URL » Telnet > POP3 » SMTP

Question No: 5 ( Marks: 1) - Please choose one
Aliasing problem can be managed by the size of pixels.
» Reducing » Increasing » Gaining » Modifying

Question No: 6 ( Marks: 1) - Please choose one
Serial arrangement in which things follow logical order or a recurrent pattern, such as
statements executing one by one, is called .

» Loop > Sequence » Condition » Array
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Question No: 7 ( Marks: 1) - Please choose one
Which of the following data types are recognized by JavaScript?
» Strings » Numbers P Undefined P All of the given options

Question No: 8 ( Marks: 1) - Please choose one
a = Math.ceil(12.01)
What will be the value of a ?

> 12 > 13 > 12.0 > 13.01

Question No: 9 ( Marks: 1) - Please choose one
In the old days, databases did NOT support .
» Number » Boolean » Video » Text

Question No: 10 ( Marks: 1) - Please choose one
The organizations are learning that business can be done in a more effective manner if
emphasis is placed upon

» Cooperation P Shared respons1b111ty » Networking

> All of the given options

Question No: 11 ( Marks: 1) - Please choose one
Module level design is the responsibility of the .
» Architect » Team Lead » Developer P CEO

Question No: 12 ( Marks: 1) - Please choose one
errors are caused by the code that somehow violates the rule of the language.
> Syntax » Semantic B Run time P Load time

Question No: 13 ( Marks: 1) - Please choose one
The world first computer program was written to compute:

» Simple sequence » Multiple sequence

> Bernoulli’s sequence » Increasing sequence
Question No: 14 ( Marks: 1) - Please choose one
Microsoft Word is a type of:

» System Software » Freeware Software

» Shrink-Wrapped Software P Custom-built Software

Question No: 15 (Marks: 1) - Please choose one

We need for memory management in computer
» Software » Hardware P Operating System
» Application Software

Question No: 16 (Marks: 1) - Please choose one
is generally measured in terms of the number of steps required to execute an
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algorithm.
» Space » Time P Memory and time P Bandwidth

Question No: 17 ( Marks: 1) - Please choose one
PowerBuilder falls in the category of .
» Assembly Languages > 4-th Generation Languages
» Machine Languages » High-Level Languages

Question No: 18 ( Marks: 1) - Please choose one
means to break down into simpler components and analyze.
» Recursion P_ Parsing » Scope » Navigation

Question No: 19 (Marks: 1) - Please choose one
for(var i=1; i<=2;i=i+1)

{
document.write( "Sorted Words:" + "<BR>" )
}
Which of the following shall be the output of above code:

» Sorted Words: Sorted Words: P Sorted Words:Sorted Words:
» Sorted Words: “<BR>"” Sorted Words: “<BR>"

» Sorted Words: <BR> Sorted Words: <BR> (correct)

Question No: 20 ( Marks: 1) - Please choose one
Assembly languages allow a programmer to use for numbers.
» Object » Entity > Name P Interpreter

Question No: 21 ( Marks: 1) - Please choose one
means you have only one container to store more than one value in JavaScript.

» Variable » Matrix > Array » String

Question No: 22 ( Marks: 1) - Please choose one

Coding is the responsibility of
» Software design P Software developer P Project manager
» None of given

Question No: 23 ( Marks: 1) - Please choose one

CEO stands for
» Central Executive officer » Chief External officer
» Chief executive officer » None of given

Question No: 24 ( Marks: 1) - Please choose one
Decision Support Systems will become a bigger part of the professional life of the
» Doctors » Mangers » Marketers » All of above

Question No: 25 ( Marks: 1) - Please choose one
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The output of fuzzy Logic System is computed by using Technique.
» MAX-MAX » MAX-MIN p MIN-MAX » None of the given

Question No: 26 ( Marks: 1) - Please choose one

In the statement Math.PI, Math is and PI is
» Variable, Constant » Object , Method
» Object , Function » Object, Property

FINALTERM EXAMINATION
CS101- Introduction to Computing (Session - 2)

Question No: 1 (Marks: 1) - Please choose one

It represents the flow chart element.

» Process » Input or Output P Decision » Connector

Question No: 2 (Marks: 1) - Please choose one
Website design should NOT be )
» Unified » Complex » Consistent » Predictable

Question No: 3 (Marks: 1) - Please choose one
The most upper right pixel of the screen is of color.
> Any » Red » Green » Blue

Question No: 4 (Marks: 1) -Please choose one
Which of the following is NOT an example of Multi-user Operating system

» Windows » Linux » DOS » Solaris

Question No: 5 (Marks: 1) - Please choose one
According to the heuristic, the number of defects remaining in a system after a given level of tests is
proportional to .
» The number found on very first day.
» The number found during the development.
» The number found during the test.
» None of the given options.
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Question No: 6 (Marks: 1) - Please choose one
Which one of the following is NOT a component of Rule Based System?
» Rule Compiler » Rule Interpreter » Rules Base » Working Memory

Question No: 7 (Marks: 1) - Please choose one
In RDBMS, table rows are called :
» Field » Record » Column » Query

Question No: 8 (Marks: 1) - Please choose one
can be used for entering, editing, or viewing data, one record at a time.
» Queries » Forms » Reports » None of the given options

Question No: 9 (Marks: 1) - Please choose one
Tribal flood network is a software.
» DoS » Scanning P Utility » None of the given options

Question No: 10 (Marks: 1) - Please choose one
Unlike virus, is a stand-alone program.
» Trojan horse » Logic bomb » Worm » Time bomb

Question No: 11 (Marks: 1) - Please choose one
The key responsibilities of a project manager is
» Planning and tracking of the project
» Arranging of the appropriate resources

» Client relationship management
» All of the given options

Question No: 12 (Marks: 1) - Please choose one
The key responsibilities of the architect of the project is
» Technology selection
» High-level design
» Makes certain that the implementation remains true to the design
» All of the given options

Question No: 13 (Marks: 1) - Please choose one
is responsible for day to day operations.
» CEO » COO » CMSO » Developer

Question No: 14 (Marks: 1) - Please choose one

onAbort , onError are the of the image object.
» Event Handler » Properties » Methods
» None of the given options

Question No: 15 (Marks: 1) - Please choose one
The tasks performed to detect the exact location of defect is called
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» Debugging » Testing » Repairing » Monitoring

Question No: 16 (Marks: 1) - Please choose one
routes the packets through the internet to go to their destination.
» Protocol » TCP > IP » NIC

Question No: 17 (Marks: 1) - Please choose one
When we buy a software package, we do not really buy it, we just by a license that allows us to use it,
the stays with the maker.

» Agreement » Ownership » Membership » Software

Question No: 18 (Marks: 1) - Please choose one

Sequence of steps that is taken to solve a problem is called .
» Algorithm » Operating System P Application software
» None of the given options

Question No: 19 (Marks: 1) - Please choose one
A collection of data organized in such a way that the computer can quickly search for a desired data
item is known as :

» Retrieving » Database » Information » DBMS

Question No: 20 (Marks: 1) - Please choose one
To start an ordered list from 20 instead of 1, we will write
» <OL begin = “20"> » <OL initiate = “20">
» <OL start = “20"> » <OL from = “20">

Question No: 21 (Marks: 1) - Please choose one
are personal computers that are designed to be easily transported and relocated.
» Desktops » Portables » Servers » Workstations

Question No: 22 (Marks: 1) - Please choose one
To display a multi-line text area on the web page, we use __ tag
» TEXT » TEXTAREA » INPUT » INPUTAREA

Question No: 23 (Marks: 1) - Please choose one
The first component of an operating system that runs when a typical computer is turned ON, is:
» Device Manager » File Manager » Loader » Device Driver

Question No: 24 (Marks: 1) - Please choose one
Pseudo code is written in
p Complex grammar P Plain English » JAVA » Pseudo language

Question No: 25 (Marks: 1) - Please choose one
Instead of Full System, one can results from part of a System
» Not achieve » Mostly achieve » Sometimes achieve » Achieve
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Question No: 26 (Marks: 1) - Please choose one
One can download or upload files to a remote computer using protocol.
» HTTP » SMTP » FTP » TELNET

Question No: 27 (Marks: 1) - Please choose one
Which protocol is used to control other computer from our own computer ?
» FTP » NNTP » TELNET » None of the given choices

Question No: 28 (Marks: 1) - Please choose one
Which function returns a randomly selected floating point number between 0 and 1 ?
» floor(x) » ceil(x) » random() » round(x)

Question No: 29 (Marks: 1) - Please choose one
Global variables can make the logic of a web page.

» Difficult to understand

» Easier to understand and maintain

» Difficult to reuse and maintain

» Difficult to understand, reuse and maintain

Question No: 30 (Marks: 1) - Please choose one

Mathematical functions in JavaScript, are accessed by referring to various methods of the
object.

» Math » Calculate » Compute » None of the given options

FINALTERM EXAMINATION
CS101- Introduction to Computing (Session - 2)

Question No: 1 (Marks: 1) -Please choose one
Human are better than computers at:
» Efficiency » Accuracy » Pattern recognition » None of the given choices

Question No: 2 (Marks: 1) -Please choose one

TCP stands for )
» Total communication protocol » Transmission control protocol
» Transfer control protocol » Transfer collection protocol

Question No: 3 (Marks: 1) -Please choose one
First computer network was .
» NSFNET » FIRSTNET » ARPANET » ORPHANET

Question No: 4 (Marks: 1) -Please choose one
A user may access any item on the web through
» URL » Telnet » POP » SMTP
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Question No: 5 (Marks: 1) -Please choose one
In JavaScript, a variable declaration is
» Optional » Mandatory » Not allowed » None of the given

Question No: 6 (Marks: 1) -Please choose one

According to a popular heuristic, success is defined by
» The user » The builder » Both user and builder
» None of the given options

Question No: 7 (Marks: 1) -Please choose one

To store rounded number of 8.6 in a variable called "r_number", we write
» r_numbers=Maths.rounds(8.6) » r_number=Math.rounds(8.6)
» r_number=Math.round(8.6) _ » r_number=Maths.round(8.6)

Question No: 8 (Marks: 1) -Please choose one
random() function returns a randomly-selected, floating-point number between
» 0 and 1 » 0and 10 » 0 and-10 » 0and -1

Question No: 9 (Marks: 1) -Please choose one
Trinoo is a software.
» DoS » Scanning » Utility » None of the given options

Question No: 10 (Marks: 1) -Please choose one
Which attribute of the IMG tag tells us about the source of the image
» source » path » loc » src

Question No: 11 (Marks: 1) -Please choose one
The developer report to in a development team.
» Team Lead » Project Manager » CEO » IT Manager

Question No: 12 (Marks: 1) -Please choose one

The effective way not to only write programs but also it works properly and further more to minimize

the time and the development cost of the program is called
» Programming Mechanism » Programming Methodology
» Programming Synchronization » None of the given options

Question No: 13 (Marks: 1) -Please choose one

TCP stands for :
» Transfer Center protocol » Transmission Control Protocol
B Transmission Center Protocol » Telephone Center Protocol

Question No: 14 (Marks: 1) -Please choose one
When we buy a software package, we do not really buy it, we just by a license that allows us to use it,
the stays with the maker.

» Agreement » Ownership » Membership » Software
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Question No: 15 (Marks: 1) -Please choose one

Many developers write the first and then incrementally convert each line into
» Real code & Pseudo code » Pseudo code & Real code
» Real code & Artificial code » None of the given options

Question No: 16 (Marks: 1) - Please choose one
Collection of facts & figures is called .
» Information » Data » Entity > Attribute

Question No: 17 (Marks: 1) -Please choose one
A collection of data organized in such a way that the computer can quickly search for a desired data
item is known as :

» Retrieving » Database » Information » DBMS

Question No: 18 (Marks: 1) -Please choose one
To start an ordered list from 20 instead of 1, we will write
» <OL begin = “20"> » <OL initiate = “20">

» <OL start = “20"> » <OL from = “20">

Question No: 19 (Marks: 1) -Please choose one

Using COLSPAN, number of rows of the current cell should extend itself
» Upward » Downward
» Both Upward and Downward » None of the given choices

Question No: 20 (Marks: 1) -Please choose one
Microsoft Word is a type of:
» System Software > Freeware Software
» Shrink-Wrapped Software » Custom-built Software

Question No: 21 (Marks: 1) -Please choose one
Compound Statement after decision constructs in JavaScript is enclosed with

»() »[1 »{h »{}

Question No: 22 (Marks: 1) -Please choose one
Users , how things work.
» Analyze in detail » Muddle through » Figure out » Read in detail

Question No: 23 (Marks: 1) -Please choose one
One can send an email message to a remote computer using protocol
» HTTP » SMTP » FTP » TELNET

Question No: 24 (Marks: 1) -Please choose one
Writing a response, multiple statements are separated from each other with the help of

» Period (.) » Comma (, ) » Colon (:) » Semicolon ( ;)
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Question No: 25 (Marks: 1) -Please choose one
With the passage of time the field of Computing and Telecommunication is
» Diverging » Converging » Becoming different » Becoming unique

Question No: 26 (Marks: 1) -Please choose one
When we have to show value as part of a whole picture, which type of chart is used.
» Bar chart » Pie chart P Line graph » None of the given

Question No: 27 (Marks: 1) -Please choose one
software directly interacts with the user.
» Application software » System software

» Anonymous software » Interactive software

Question No: 28 (Marks: 1) -Please choose one
Global variables can make the logic of a web page.
» Difficult to understand » Easier to understand and maintain
» Difficult to reuse and maintain » Difficult to understand, reuse and maintain

Question No: 29 (Marks: 1) -Please choose one
In partitioning of program/modaule, it should be assured that partitioned chunks should be as
as possible.
» Dependent » Independent » Complex » All of the above

FINALTERM EXAMINATION
CS101- Introduction to Computing (Session - 2)
Question No: 1 (Marks: 1) - Please choose one
The memory size of the Altair 8800 was
» 128 bytes » 128 Kilo bytes » 256 Kilo bytes > 256 bytes

Question No: 2 (Marks: 1) - Please choose one
A named collection of properties (data, state) and methods (instruction, behavior) is called
» Array P Function P Variable > Object

Question No: 3 ( Marks: 1) - Please choose one

JavaScript Variables are .
B Dynamically Typed » Statically Typed » Strong Typed
» None of the given options

Question No: 4 (Marks: 1) - Please choose one
Serial arrangement in which things follow logical order or a recurrent pattern, such as statements executing one
by one, is called
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» Loop » Sequence » Condition > Array

Question No: 5 (Marks: 1) - Please choose one
Rule of thumb learned through trial and error is called
» Design » Heuristic » Plan > Aim

Question No: 6 (Marks: 1) - Please choose one
According to heuristic, if you can’t explain it in minutes, either you don’t understand it or it does
not work.

> 10 »2 »5 p»4

Question No: 7 (Marks: 1) - Please choose one

To store rounded number of 8.6 in a variable called "r_number", we write
» r numbers=Maths.rounds(8.6) » r number=Math.rounds(8.6)
» r number=Math.round(8.6) » r number=Maths.round(8.6)

Question No: 8 (Marks: 1) - Please choose one

Using only HTML we can create
» Dynamic web pages P Static web pages
» Both Static and Dynamic pages » None of these

Question No: 9 (Marks: 1) - Please choose one
function returns the largest integer that is less than or equal to x.
» round(x) » floor » ceil > abs(x)

Question No: 10 (Marks: 1) - Please choose one
Due to working at home, contact with the colleagues is , which may result in quality of
work

» Reduced, Poorer P Reduced, Better P Increased, Poorer P Increased, Better

Question No: 11 (Marks: 1) - Please choose one
The distance among families is because of spending more time on internet.
» Increased » Expanded » Contracted » Decreased

Question No: 12 ( Marks: 1) - Please choose one
When web server is busy it gives the following message to the user :
» Time out > Waiting » Server busy » None of the given options

Question No: 13 (Marks: 1) - Please choose one
is designed for detecting viruses and inoculating.
» Antivirus » Utility P Trojan P None of the given choices

Question No: 14 (Marks: 1) - Please choose one
The is becoming the preferred organizational structure for more and more organizations with the
passage of time.
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» Tree structured organizational model P> Network paradigm
» Hierarchical structure » None of the given options

Question No: 15 (Marks: 1) - Please choose one
Planning and tracking of the project is the responsibility of the
» Project Manager P Architect P Developer P> Chief Executive Ofﬁcer

Question No: 16 (Marks: 1) - Please choose one
The responsibilities of the Team Lead includes
» Planning and tracking of the project
P Detailed design
» Professional development of team members
» All of the given options

Question No: 17 (Marks: 1) - Please choose one
team is responsible for a project after the specification’s stage till the very end.
» Executive » Architect » Development » HR

Question No: 18 ( Marks: 1) - Please choose one
There are types of errors.
> 2 >3 > 4 » 5

Question No: 19 (Marks: 1) - Please choose one
are the computers that perform at or near the currently highest operational rate for computers.
» Minicomputers P Microcomputers P Supercomputers P Personal Computers

Question No: 20 (Marks: 1) - Please choose one
Which one of these is NOT an example of storage devices?
» Tape > RAM » Floppy » DVD

Question No: 21 (Marks: 1) - Please choose one
Forms can be submitted by using different methods
> 2 >3 > 4 > 5

Question No: 22 (Marks: 1) - Please choose one
Which is NOT true for JavaScript variable name ?
» Student » Roll no 1111 » For » schedule

Question No: 23 (Marks: 1) - Please choose one
One can browse documents residing on a remote computer using protocol.
> HTTP » SMTP » FTP » TELNET

Question No: 24 (Marks: 1) - Please choose one
Which one is the example of spreadsheet software ?
» MS Word » MS PowerPoint > MS Excel » MS Access
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Question No: 25 (Marks: 1) - Please choose one

User can remotely log on to a computer and can have a control over it like a local user using
» TelNet Protocol
> TelNet Protocol and connected to the user through TCP/IP network
» TelNet protocol and FTP » TCP/IP and FTP

Question No: 26 (Marks: 1) - Please choose one
Hardware malfunctions is related to
» Data updates P Data integrity P> Data security P Data accessibility

Question No: 27 (Marks: 1) - Please choose one
PowerBuilder falls in the category of .
» Assembly Languages » 4-th Generation Languages
» Machine Languages » High-Level Languages

Question No: 28 (Marks: 1) - Please choose one
Backbone is also called as .
> vBNS » BNS » vHBNS » HBNS

Question No: 29 (Marks: 1) - Please choose one
Global variables can make the logic of a web page.
» Difficult to understand » Easier to understand and maintain
» Difficult to reuse and maintain » Difficult to understand, reuse and maintain

Question No: 30 ( Marks: 1) - Please choose one

In JavaScript: In order to display the text on browser Grade A, which of following statement is True.
» documentwrite( "Grade A") » document.write( ""Grade A");
» document.write( "Grade” && A"); P document.write( "Grade” && “A");

FINALTERM EXAMINATION
CS101- Introduction to Computing (Session - 3)
Question No: 1 (Marks: 1) -Please choose one
First computer network was .
» NSFNET » FIRSTNET » ARPANET » ORPHANET

Question No: 2 (Marks: 1) -Please choose one
In a good presentation each slide should contain

» Heading P Phrases not sentences P Sentences not phrases » Heading, sentences not
phrases

Question No: 3 (Marks: 1) -Please choose one
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A function is also called

» Sub-program » Procedure » Sub-routine > All of the given option

Question No: 4 (Marks: 1) -Please choose one
A single pixel can acquire approximately color schemes.
» 1 million » 2 million » 10 million » 16 million

Question No: 5 (Marks: 1) -Please choose one
Which of the following is NOT a Loop statement?
» For » While » Switch » Do-While

Question No: 6 (Marks: 1) -Please choose one
Which one of the following is NOT a component of Rule Based System?
» Rule Compiler » Rule Interpreter » Rules Base » Working Memory
Question No: 7 (Marks: 1) -Please choose one
Spread sheet is a type of

P Productivity software P Engineering software P Mathematical software P Business software

Question No: 8 (Marks: 1) -Please choose one
A combination of word processing and graphic design is

» Corel Draw  » Desktop Publishing » Paint » WordPad

Question No: 9 (Marks: 1) - Please choose one

To store rounded number of 8.6 in a variable called "r_number", we write
» r numbers=Maths.rounds(8.6) » r number=Math.rounds(8.6)
» r number=Math.round(8.6) » r number=Maths.round(8.6)

Question No: 10 (Marks: 1) -Please choose one
Which of the following is a true statement?

» Flat-file storage is better than tabular storage.

» Tabular storage is better than flat-file storage.

P Flat-file storage is better than relational storage.

» None of the given options

Question No: 11 (Marks: 1) -Please choose one

The political process is also influenced by the use of .
» Discussion forums » Newsgroups » Mailing lists
> All of the given options

Question No: 12 (Marks: 1) -Please choose one

www.virtualstudysolutions.blogspot.com




The system that manages relational database, is called
» None of the given options
» Database Management System
» Data Management System
P Relational Database Management System

Question No: 13 (Marks: 1) -Please choose one
DBMS supports data in terabytes.
» Personal » Desktop » Enterprise » Single-user

Question No: 14 (Marks: 1) -Please choose one
Trinoo is a software.
> DoS P Scanning » Utility » None of the given options

Question No: 15 (Marks: 1) -Please choose one
What is the major problem with flash based website?
» Its two heavy » Cannot be indexed » Less attractive » Inaccessible

Question No: 16 (Marks: 1) -Please choose one
The organization is the collection of .
» Peoples » Professionals » Teams » Individuals

Question No: 17 (Marks: 1) -Please choose one
The tasks performed to determine the existence of defects is called
» Debugging » Testing P Repairing » Coding

Question No: 18 (Marks: 1) -Please choose one

Many developers write the first and then incrementally convert each line into
» Real code & Pseudo code > Pseudo code & Real code
» Real code & Artificial code » None of the given options

Question No: 19 (Marks: 1) -Please choose one
Forms can be submitted through & methods
» INCLUDE, POST » INCLUDE, GET
» GET, POST » SEND, POST

Question No: 20 ( Marks: 1) -Please choose one

If an algorithm is syntactically correct, but semantically incorrect then this situation is
» Very good situation » Very dangerous situation
» Not very bad » Neutral situation

Question No: 21 (Marks: 1) -Please choose one
Heuristics lead to the best results.
P Sometimes » Do not » Occasionally » Not always

Question No: 22 (Marks: 1) -Please choose one
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In TCPIP communication fragmentation is responsibility of
» TCP > IP » Both TCP and IP P Internet

Question No: 23 (Marks: 1) -Please choose one
Access to the internet became easy after the invention of

> WWW & Web Browsers

» Mainframes

» Binary system

» Signals

Question No: 24 (Marks: 1) -Please choose one
Which one is the example of spreadsheet software ?
» MS Word » MS PowerPoint » MS Excel » MS Access

Question No: 25 (Marks: 1) -Please choose one
User can remotely log on to a computer and can have a control over it like a local user using
» TelNet Protocol
» TelNet Protocol and connected to the user through TCP/IP network
» TelNet protocol and FTP
» TCP/IP and FTP

Question No: 26 (Marks: 1) -Please choose one
If incorrectly we enter the negative age it is check by
» Limit Integrity » Type Integrity P Referential Integrity » Physical Integrity

Question No: 27 (Marks: 1) -Please choose one

------------------ is a digital programmable mechanical machine
» Analytical Engine » Difference Engine » Harvard Mark 1 P Mechanical engine

Question No: 28 (Marks: 1) - Please choose one

This element of Flow Chart is called )
» Process » Off page connector » Decision » Connector

Question No: 29 ( Marks: 1) -Please choose one

In a library’s database, if there is an entry in the register for Book # 423 then the corresponding Book must
actually exist; is an example of which type of data integrit

» Type integrity » Limit integrity P Physical Integrity P Referential Integrity

Question No: 30 (Marks: 1) -Please choose one
Ada is a programming language specifically designed for
» Analytical Engine P Difference Engine P Harvard Mark 1 » Mechanical engine
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FINALTERM EXAMINATION
CS101- Introduction to Computing (Session - 1)
Question No: 1 (Marks: 1) -Please choose one
Cray-1 was first commercial computer
> Super » Mini » Micro » Personal

Question No: 2 (Marks: 1) -Please choose one
The name of first browser was
» Internet Explorer » Moziac » Netscape » Firefox

Question No: 3 (Marks: 1) -Please choose one
The impact of a digit in a number is determined by its ---------------
» Value » Location » Length » None of above

Question No: 4 (Marks: 1) -Please choose one
First computer network was .
» NSFNET » FIRSTNET » ARPANET » ORPHANET

Question No: 5 (Marks: 1) -Please choose one
A variable can be in scope.
» Local » Global » Either local or global
» None of the given options

Question No: 6 (Marks: 1) -Please choose one
color should be used in background for a good presentation.

» Light » Dark » Red » None of the given options
Question No: 7 (Marks: 1) -Please choose one
Which one of the following is not an event handler's attribute?

» Function » Identifier » Equal sign

» String consisting of JavaScript statements

Question No: 8 (Marks: 1) -Please choose one
Variables allow us to manipulate data through the .
» Actual Value » Reference > Length » Name

Question No: 9 (Marks: 1) -Please choose one
Which one of the following is NOT a component of Rule Based System?
» Rule Compiler » Rule Interpreter » Rules Base » Working Memory

Question No: 10 (Marks: 1) -Please choose one
Fuzzy logic is based on
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» Ground facts » Experience » Practice » Approximation

Question No: 11 (Marks: 1) - Please choose one
a = Math.ceil(12.01)
What will be the value of a ?

> 12 > 13 » 12.0 > 13.01

Question No: 12 (Marks: 1) -Please choose one
Tag used to make a Text Bold is

» <BOLD></BOLD> p <B></B> » <BODY></BODY> » None of these

Question No: 13 (Marks: 1) -Please choose one
<P> </P> and <BR> tags are not same because

» <p></p> goes to the next line

» <BR> goes to the next after next line

» <P></P> goes to the next after next line
» Both are same

Question No: 14 (Marks: 1) -Please choose one
Event handlers are placed in the portion of a Web page as attributes in HTML tags.
» HEAD » BODY » SCRIPT » TITLE

Question No: 15 (Marks: 1) -Please choose one
Due to working at home, lack of interaction may result in professional growth.
» Slower » Faster » Higher » Improved

Question No: 16 (Marks: 1) - Please choose one
DBMS supports data in terabytes.
» Personal » Desktop » Enterprise » Single-user

Question No: 17 (Marks: 1) -Please choose one
waits for some time and then launch a function.
» Timeout( ) > setTimeout() » setTime() » setTimeln()

Question No: 18 ( Marks: 1) -Please choose one
The responsibilities of the Team Lead includes
» Planning and tracking of the project

» Detailed design
» Professional development of team members
» All of the given options

Question No: 19 (Marks: 1) -Please choose one
is also known as System Architecture
» High level system design
» Low level system design
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» Every system design
» Software Requirement

Question No: 20 (Marks: 1) -Please choose one
The key property of the ‘Array’ object in JavaScript is

» Value > Length » Name

» All of the given choices

Question No: 21 (Marks: 1) -Please choose one
There are ways of calling functions.
» One » Two » Three » Four

Question No: 22 (Marks: 1) -Please choose one

Which event handler executes the specified JavaScript code when a window/form element loses focus
?

» onBlur » onlLoad » onUnload » onFocus

Question No: 23 (Marks: 1) -Please choose one
Popular schemes used for reducing bytes for storage are:
» RGB and Color mapping
» RGB and Dithering
» RGB, Color mapping and Dithering
» Color mapping and Dithering

Question No: 24 (Marks: 1) -Please choose one
Hardware malfunctions is related to
» Data updates P Data integrity P Data security P Data accessibility

Question No: 25 (Marks: 1) -Please choose one
Users communicate with the computer using a consistent user interface provided by the OS. » True
» False

Question No: 26 (Marks: 1) -Please choose one
Extension for saving web page is / are;
» *.html » *.htm » *.html and *.htm both are in use
» None of These

Question No: 27 (Marks: 1) -Please choose one
loop is a flow control statement that allows code to be executed repeatedly based on
a given Boolean condition.

B For » Do-While > If-else » While

Question No: 28 (Marks: 1) -Please choose one
onBlur event is occurred for a form element when it

» Gets focus » Losts focus
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» Some thing is typed in » onBlur is not an event

Question No: 29 (Marks: 1) -Please choose one
<script>

Number=new Array(5);

for(var i=1; i<=5; i=i+1)

{
for( var k=6; k<=10; k=k+1)
{
Numberl[i]= k*i;
}
}
</script>

For how many times the Nested For Loop shall execute;

> 20
» 15
» 25
» Shall terminate in first loop.

Question No: 30 (Marks: 1) -Please choose one
In JavaScript: In order to display the text on browser Grade A, which of following statement is True.

» documentwrite( "Grade A") » document.write( "Grade A");
» document.write( "Grade” && A"); » document.write( "Grade” && “A");

FINALTERM EXAMINATION
CS101- Introduction to Computing (Session - 4)

Question No: 1 ( Marks: 1) - Please choose one
Success of a website 1s defined by .
» Use» Designer » Developer » Programmer

Question No: 2 (Marks: 1) - Please choose one
Which one is correct for JavaScript?

» onMouseOver » OnMouseOver » onmouseover » All of the given

Question No: 3 (Marks: 1) - Please choose one

www.virtualstudysolutions.blogspot.com




An indexed list of elements is called .
» Collection > Array > Set » Group

Question No: 4 (Marks: 1) - Please choose one
is the way that internet domain names are located and translated into IP addresses.
» FTP » VoIP > DNS » TCP

Question No: 5 (Marks: 1) - Please choose one
The browser breaks down the URL into parts.
> 2 >3 > 4 > 5

Question No: 6 (Marks: 1) - Please choose one
Which one of the following is not an event handler's attribute?

» Function » Identifier » Equal sign

» String consisting of JavaScript statements

Question No: 7 (Marks: 1) - Please choose one

JavaScript Variables are .
» Dynamically Typed » Statically Typed
» Strong Typed » None of the given options

Question No: 8 (Marks: 1) - Please choose one
Which of the following is NOT a Loop statement?
» For » While » Switch » Do-While

Question No: 9 (Marks: 1) - Please choose one
According to a popular heuristic, success is defined by .
» The user » The builder » Both user and builder P None of the given options

Question No: 10 ( Marks: 1) - Please choose one
Which one of the following is an application for artificial intelligence?
» Robotic » Web Agent » Decision Support System P All of the given options

Question No: 11 ( Marks: 1) - Please choose one
Using only HTML we can create

» Dynamic web pages P> Static web pages

» Both Static and Dynamic pages

» None of these

Question No: 12 (Marks: 1) - Please choose one
The is connected to all other modules of the microprocessor.

» Control unit » Memory unit » Floating Point unit ~ » Arithmetic and Logic unit




Question No: 13 (Marks: 1) - Please choose one
Which of the followings is NOT a Relational DBMS software.
» Access » FrontPage » FileMaker Pro » SQL Server

Question No: 14 (Marks: 1) - Please choose one

country="Hello Pakistan”;

document.write(country.length);

The out put of the above statement is
> 12 > 13 > 14 > 15

Question No: 15 (Marks: 1) - Please choose one
The distance among families is because of spending more time on internet.
» Increased » Expanded P Contracted » Decreased

Question No: 16 ( Marks: 1) - Please choose one
is a field that uniquely identifies each record stored in a table.
» Composite Key » Primary key » Foreign key » None of the given options

Question No: 17 (Marks: 1) - Please choose one
Planning and tracking of the project is the responsibility of the .
» Architect » Team Lead » Developer » Chief Executive Officer

Question No: 18 (Marks: 1) - Please choose one
has great PR skills.
» Architect » Team Lead » Project Manager # Chief Executive Officer

Question No: 19 (Marks: 1) - Please choose one
team is responsible for a project after the specification’s stage till the very end.
» Executive » Architect » Development » HR

Question No: 20 (Marks: 1) - Please choose one
A large number of networks interconnected physically is called
> LAN > WAN » Internet » Network collection

Question No: 21 (Marks: 1) - Please choose one
Efficiency is to universality
» Equal » Direct proportional » Inversely proportional » Not proportional

Question No: 22 (Marks: 1) - Please choose one
There are ways of calling functions.
B One » Two » Three » Four

Question No: 23 (Marks: 1) - Please choose one
Which protocol is use to transfer a file over the network?
» UDP > FTP » TCP » OSI
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Question No: 24 (Marks: 1) - Please choose one
Writing a response, multiple statements are separated from each other with the help of

» Period (.) » Comma(, ) » Colon (:) » Semicolon ( ;)

Question No: 25 (Marks: 1) - Please choose one
Popular schemes used for reducing bytes for storage are:
» RGB and Color mapping » RGB and Dithering
» RGB, Color mapping and Dithering » Color mapping and Dithering

Question No: 26 (Marks: 1) - Please choose one

has the ability to automate and simplify daily tasks.
» Productivity software > Application software

» System software » Graphical software

Question No: 27 (Marks: 1) - Please choose one
Which representation technique of algorithm is more suitable for developer to make actual code

» pseudo code » flow chart » both pseudo code and flow chart » Heuristics

Question No: 28 (Marks: 1) - Please choose one
is used to terminate all JavaScript statements.
» Colon » Semicolon » Underscore P> Apostrophe

Question No: 29 (Marks: 1) - Please choose one
CONCATENATE operator is used to elements.

» Subtract » Multiply » Join » Add

Question No: 30 ( Marks: 1) - Please choose one
In partitioning of program/module, it should be assured that partitioned chunks should be as
as possible.

» Dependent » Independent » Complex » All of the abov

FINALTERM EXAMINATION
CS101- Introduction to Computing (Session - 3)

Question No: 1 (Marks: 1) -Please choose one
The memory size of the Altair 8800 was
» 128 bytes » 128 Kilo bytes » 256 Kilo bytes » 256 bytes
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Question No: 2 (Marks: 1) -Please choose one
Hexadecimal number system is based on digits
> 2 > 8 > 12 > 16

Question No: 3 (Marks: 1) -Please choose one
Which one of the following is not an event handler's attribute?

» Function » |dentifier » Equal sign

» String consisting of JavaScript statements

Question No: 4 (Marks: 1) -Please choose one
Which is correct?

» onUnload » onUnLoad » onUNLOAD » All of the above

Question No: 5 (Marks: 1) -Please choose one
The most upper right pixel of the screen is of color.
> Any » Red » Green » Blue

Question No: 6 (Marks: 1) -Please choose one
Which of the following is NOT a Loop statement?
» For » While » Switch » Do-While

Question No: 7 (Marks: 1) -Please choose one
When’+’ operator is used with string operands, it both strings.
» Adds » Subtracts » Concatenates » Compares

Question No: 8 (Marks: 1) -Please choose one
organization is replacing the old-style layered, tree-structured organizational model.
» Network » Hierarchical » Matrix » None of the given options

Question No: 9 (Marks: 1) -Please choose one
Due to working at home, lack of interaction may result in professional growth.
® Slower Faster Higher Improved

Question No: 10 (Marks: 1) -Please choose one

Spies of one business monitoring the network traffic of their competitors’ .
¢ _Industrial Intelligence Industrial Espionage Industrial Spying Industrial

Surveillance

Question No: 11 (Marks: 1) -Please choose one
The key responsibilities of a project manager is
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Planning and tracking of the project Arranging of the appropriate resources
Client relationship management © All of the given options

Question No: 12 (Marks: 1) -Please choose one
Sequence of steps that is taken to solve a problem is called

OAlgorithm ©Operating System ©Application software (©None of the given options

Question No: 13 (Marks: 1) - Please choose one

CELLPADDING determines the distance between the of the cell and the contents of
the cell
Caption__ & Border Alignment Empty space

Question No: 14 (Marks: 1) -Please choose one
DSS stands for:

Dual System Security Decision Support System Digital System
Solver & Dynamic System Security

Question No: 15 (Marks: 1) -Please choose one
Flow control constructs in JavaScript includes:
If-Else Loops and If -Else & Switch and [f-Else All of the given choices

Question No: 16 (Marks: 1) -Please choose one
Assignment operator in JavaScript is represented by:
= == O => >=

Question No: 17 (Marks: 1) -Please choose one

In a System having many parts to be designed, one should always do the first
© Hard part Simple part @ Development part Quality part

Question No: 18 (Marks: 1) -Please choose one
Which protocol is used to send email ?
FTP ® SMTP ©® TELNET All of the given choices

Question No: 19 (Marks: 1) -Please choose one
Those Systems are “Intelligent System” that mimics some aspects of
Software deployment_ © Human thought Speaking power® Computing

Question No: 20 (Marks: 1) -Please choose one

<script>

Number=new Array(5);for(var i=1; i<=5 ; i=i+1)

{
for( var k=6; k<=10; k=k+1)

{
Number(i]= k*i;
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}

</script>
For how many times the Nested For Loop shall execute;
20 15 25 (® Shall terminate in first loop.

Question No: 21 (Marks: 1) -Please choose one
Which of the following is a valid html tag?
» <html> » <HTML> » <htML> » All of the above

Question No: 22 (Marks: 1) -Please choose one
Which of the following memory retains its information when the power to the system is turned off?
» RAM » ROM » DIMM » DRAM

Question No: 23 (Marks: 1) -Please choose one
The output of document.write( "2" + Math.Pl ) ; is

> 23.141592653589793 » 3.146 P 2.3141592653589793 » None of them

Question No: 24 (Marks: 1) -Please choose one
Logic Bombs executes its payload when
» A programs run
» A predetermined event occurs
» DoS attack is launched
» A file is copied from one folder to another

Question No: 25 (Marks: 1) -Please choose one
Which Internet Service is comparatively Slow but Inexpensive and Fast.
» E-mail » Instant Messaging » Web » None of the given

Question No: 26 (Marks: 1) -Please choose one

Super computers consists of more than one parallel processors because
» One big processor is more expensive than parallel processors
» Through parallel processors problems can be solved easily
» Small processors are easy to manufacture
» All of the given

MIDTERM EXAMINATION
Fall 2008
CS$101- Introduction to Computing (Session - 2)
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Question No: 1 ( Marks: 1) - Please choose one
A procedure that usually, but not always, works or that gives nearly the right answer is called

» Algorithm » Logarithm » Heuristic » Methodology

Question No: 2 (Marks: 1) - Please choose one
Which of the following is NOT an Application Software?

» Word Processor » Web Browser » Windows XP » MS Excel

Question No: 3 ( Marks: 1) - Please choose one
Operating System talks to and manages devices through

» Loader » File Manager » Memory Manager » Device Driver

Question No: 4 ( Marks: 1) - Please choose one
You can from/to a website containing interactive forms.
» Only read » Only write > Read and write » Not read and write

Question No: 5 (Marks: 1) - Please choose one
When the user needs something to be done by the computer, he/she gives instructions in the form of
computer

» Software, Hardware » Hardware, Software

» System Software, Application Software P Graph, Monitor

Question No: 6 (Marks: 1) - Please choose one

There is a battery on the motherboard to:
» Give power to the processor > Save information when computer is off
» Save information when computer is on » Give power to the motherboard

Question No: 7 (Marks: 1) - Please choose one

is simply a fast port that lets you connect computer peripherals and consumer electronics to your

computer without restart.
» Freeware » Shareware » Firewire » Firmware

Question No: 8 ( Marks: 1) - Please choose one
Which one is correct?

» <BODY></BODY> B <body></body>
» Both <BODY></BODY> and <body></body>  » <BODY/>

Question No: 9 (Marks: 1) - Please choose one
The weaknesses of the computer are:

» Pattern recognition & Storage » Speed & Innovative ideas
P Pattern recognition & Innovative ideas » Speed & Storage

to
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Question No: 10 ( Marks: 1) - Please choose one
The key strengths of computers are

» Speed » Storage » Do not get bored > All of the given choices

Question No: 11 ( Marks: 1) - Please choose one
Which one is correct?

» <HEAD> </HEAD> » <HEAD> <END>
» <HEAD> </END>  » <HEAD> <\HEAD>

Question No: 12 ( Marks: 1) - Please choose one
Everything that JavaScript manipulates is treated as:

» Object » Window » Text » Script

Question No: 13 (Marks: 1) - Please choose one
A process in which user’s browser check the form’s data is called

» Server-Side Scripting » Client-Side Scripting
» Bowser Scripting » Form Scripting

Question No: 14 ( Marks: 1) - Please choose one
------------ is volatile memory

> RAM » ROM » Hard Disk » CD ROM

Question No: 15 (Marks: 1) - Please choose one
WYSIWYG stands for
» What you say is what you get » Where you see is where you go
» What you see is what you get  » When you see is when you get

Question No: 16 ( Marks: 1) - Please choose one
What is/are the use/uses of Word processor?

» To write a lefter » To write Research paper or report
» To create address labels » All of the given

Question No: 17 ( Marks: 1) - Please choose one
is the example of Shrink-wrapped software

» PIA information system » WinZip trial pack » Linux » MS Word

Question No: 18 ( Marks: 1) - Please choose one
interacts directly with the computer Hardware
» Compiler P Operating system » Application software » Assembler
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Question No: 19 ( Marks: 1) - Please choose one
Which of the following symbol is used for multiple line comments in JavaScript?

>/ > // > /* » //*

Question No: 20 ( Marks: 1) - Please choose one
Consider the following statement written in JavaScript:
str = "Hello” +” World”

What will be the value of str ?
» HelloWorld » Hello World » Hello + World » It will result in error

Question No: 21 ( Marks: 1) - Please choose one
give us the ability to manipulate data through reference instead of actual value.
» Constants » Variables » Data Types » Operators

Question No: 22 ( Marks: 1) - Please choose one
Bringing subsystems together to form the system is called

» Integration » Merging » Splitting » Operation & Maintenance

Question No: 23 ( Marks: 1) - Please choose one
Preliminary exploration of possible solutions, technologies, suppliers is called

P Viability » Feasibility » Specification P Integration

Question No: 24 ( Marks: 1) - Please choose one
Algorithm gives us:

» Definition of a problem > Sequence of steps to solve a problem
» Proper understanding of a problem » Solution to a problem

Question No: 25 (Marks: 1) - Please choose one
Web site is collection of related
» Web pages » Information » Search Engines » None of the given choices

Question No: 26 ( Marks: 1) - Please choose one
Information on World Wide Web is unified.

» Physically » Logically » Really » None of the given choices

FINALTERM EXAMINATION
Fall 2008
CS101- Introduction to Computing (Session - 2)
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Question No: 1 (Marks: 1) - Please choose one
Which function returns a randomly selected floating point number between 0 and 1 ?
» floor(x) » ceil(x) » random() » round(x)

Question No: 2 (Marks: 1) - Please choose one
Functions are also called:
» Heuristics » Variables » Arrays » Subprograms

Question No: 3 (Marks: 1) - Please choose one
In JavaScript, each element of array can store data of type
» A Number » An Array » A String variable »_All of the given choices

Question No: 4 (Marks: 1) - Please choose one
The weaknesses of the computer are:
» Pattern recognition & Storage » Speed & Innovative ideas
> Pattern recognition & Innovative ideas » Speed & Storage

Question No: 5 (Marks: 1) - Please choose one
Processed data is called .
» Information » Data » Entity » Attribute

Question No: 6 ( Marks: 1) - Please choose one

Many developers write the first and then incrementally convert each line into
» Real code & Pseudo code » Pseudo code & Real code
» Real code & Artificial code » None of the given options

Question No: 7 (Marks: 1) - Please choose one
When we buy a software package, we do not really buy it, we just by a license that allows us to use it, the
stays with the maker.
» Agreement » Ownership » Membership » Software

Question No: 8 (Marks: 1) - Please choose one
Name, Border, Source are the of the image object.
» Event Handler > Properties » Methods » None of the given options

Question No: 9 (Marks: 1) - Please choose one
Using smart editors they can automatically color different parts of statements in different colors e.g. HTML tags in
color.
» Green » Grey » Blue » None of the given options

Question No: 10 ( Marks: 1) - Please choose one
is in Executive team.
» Project Manager » CEO » Team Lead » Developer

Question No: 11 (Marks: 1) - Please choose one
Module level design and unit testing the responsibility of .
» Team Lead » Developer » Project Manager » Quality Assurance Expert

Question No: 12 (Marks: 1) - Please choose one
team is responsible for a project after the specification’s stage till the very end.
> Executive » Architect » Development » HR

Question No: 13 (Marks: 1) - Please choose one
waits for some time and then launch a function.
» Timeout( ) » setTimeout() » setTime( ) » setTimeln()
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Question No: 14 ( Marks: 1) - Please choose one
Which of the following is NOT an event handler for image object?
» onAbort » onError » onlLoad » onUser

Question No: 15 ( Marks: 1) - Please choose one
is a field that uniquely identifies each record stored in a table.
» Composite Key » Primary key » Foreign key » None of the given options

Question No: 16 ( Marks: 1) - Please choose one

Distance learning has got a boost due to the .
» Easy communication » Online interactive contents » Flexibility
> All of the given options

Question No: 17 ( Marks: 1) - Please choose one
By default in a web page Hyper Link for another web page is represented as

» Blue only » Black and Underlined » Blue and Bold » Blue and Underlined
Question No: 18 ( Marks: 1) - Please choose one
To store rounded number of 8.6 in a variable called "r_number", we write
» r_number=Maths.round(8.6) » r_numbers=Maths.rounds(8.6)
» r_number=Math.rounds(8.6) » r number=Math.round(8.6)

Question No: 19 (Marks: 1) - Please choose one
Which one is the best option for designing a Medical Expert System?
» Rule Based System » Genetic Algorithm » Fuzzy Logic » Neural Network

Question No: 20 ( Marks: 1) - Please choose one
Variables allow us to manipulate data through the :
» Actual Value » Reference » Length » Name

Question No: 21 (Marks: 1) - Please choose one
Which is correct?

» onUnload » onUnLoad » onUNLOAD » All of the above

Question No: 22 ( Marks: 1) - Please choose one
Capturing events and responding to them is called

» Function Handling » Event Handling » Event Procedure » All of the given option

Question No: 23 ( Marks: 1) - Please choose one
color should be used in background for a good presentation.

» Light » Dark » Red » None of the given options

Question No: 24 ( Marks: 1) - Please choose one

Which of the following symbol is used for multiple line comments in JavaScript?
>/ » // > /* » I

Question No: 25 (Marks: 1) - Please choose one
In JavaScript, what will be the result of the follwoing operation
79%3

www.virtualstudysolutions.blogspot.com



»0 »1 »2 »3

Question No: 26 ( Marks: 1) - Please choose one
A new cell using HTML is added in table row by

» <TC>...</TC> » <TR>...</TR>

» <TD>...</TD> » <NC>...</NC>

Question No: 27 ( Marks: 1) - Please choose one

TCP stands for .
» Total communication protocol » Transmission control protocol
» Transfer control protocol » Transfer collection protocol

Question No: 28 (Marks: 1) - Please choose one
What is NOT a key factor while designing a website?
» Usability » User-friendly » Consistency > Complexity

Question No: 29 ( Marks: 1) - Please choose one
It represents the flow chart element.

» Process » Input or Output » Decision » Connector

Question No: 30 (Marks: 1) - Please choose one
Vacuum tubes were replaced by
» Punch cards » Transistors » Micro Processors » Resistors

FINALTERM EXAMINATION
Spring 2009 Final
CS101- Introduction to Computing (Session - 2)

The transistor is a solid state semiconductor device used for amplification and switching, and has
__three terminals.
»one P two P three » four

Question No: 2 ( Marks: 1) - Please choose one
Blue Pacific is a name of Super___ computer.
» Mini » Desktop » Micro » Super

Question No: 3 ( Marks: 1) - Please choose one
Monte Carlo algorithm is an example of Randomized algorithm
» Randomized algorithm » Greedy algorithm

» both greedy and randomized  » Heuristics

Question No: 4 ( Marks: 1) - Please choose one
A set of stand alone productivity applications designed to work together known as __ Productivity
software suites .
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» Productivity software suites » Compiled software
» Secure software P Intelligent software

Question No: 5 ( Marks: 1) - Please choose one
The most used form tag is the <input> tag. - False
» True » False

Question No: 6 ( Marks: 1) - Please choose one
What is the key feature of computer which is against human nature.?
Can’t get bored.

» Can’t get bored. P Pattern recognition » Repetition » None

Question No: 7 ( Marks: 1) - Please choose one

____Word Processor Software _ was designed as a replacement for typewriter
» Spreadsheet Software » Word Processor Software

» Presentation Software ~ » Database Software

Question No: 8 ( Marks: 1) - Please choose one
Forms can be submitted by using 2 different methods
»2 »3 »4 »5

Question No: 9 ( Marks: 1) - Please choose one
To display a checkbox on the web page, we use _ INPUT _ tag
» CHECKBOX » CHECK » INPUT » INPUTBOX

Question No: 10 ( Marks: 1) - Please choose one
_Name __ attribute of FORM tag is used to mention a URL when the form is being submitted
» name » action » method » submit

Question No: 11 ( Marks: 1) - Please choose one
You can __ from/to a website containing interactive forms.
» Only read > Only write » Read and write » Not read and write

Question No: 12 ( Marks: 1) - Please choose one
Using COLSPAN, number of rows of the current cell should extend itself None of the given choices
» Upward » Downward

» Both Upward and Downward » None of the given choices

Question No: 13 ( Marks: 1) - Please choose one
ASCII WHITE is the fastest Super computer which can perform _1.3 trillion__ calculations in one
second.
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» 1.3 billion  » 1.3 trillion » 1.3 miillion  » 1.3 thousand

Question No: 14 ( Marks: 1) - Please choose one
_HTML____ is a related collection of WWW files that includes a beginning file called a homepage
» HTML » Website » HTTP  » Web page

Question No: 15 ( Marks: 1) - Please choose one
If a computer could pass the Turing test then it would be able to: think like human beings
» think like human beings  » do the things faster

» win a million dollar prize» store more information

Question No: 16 ( Marks: 1) - Please choose one
The key strengths of computers are - Speed
» Speed P Storage » Donotgetbored » _All of the given choices

Question No: 17 ( Marks: 1) - Please choose one
Compared to vacuum tubes, Transistors offer: All of the given choices
» Much smaller size  » Better reliability

» Much lower cost » All of the given choices

Question No: 18 ( Marks: 1) - Please choose one
Which of the following is NOT a component of IC? Resistors
» Transistors » Diodes » Resistors » Vacuum tubes

Question No: 19 ( Marks: 1) - Please choose one
When we use <INPUT type=“password”>, what will happen? - Text will be in **** format

» Text will not be visible » Text will be in normal format

» Text will be in **** format B Text will be in #### format

Question No: 20 ( Marks: 1) - Please choose one
Spread sheet is a type of _ Mathematical software
» Productivity software ~ » Engineering software
» Mathematical software  » Business software

Question No: 21 ( Marks: 1) - Please choose one
Word Processor is a Application Software
» Sysiem Software B Application Software  » Device  » Utility

Question No: 22 ( Marks: 1) - Please choose one

_Utility Program refers to the firmware code which is run by an IBM compatible PC when first powered

on.
» DOS » BIOS » Utility Program » None of these
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Question No: 23 ( Marks: 1) - Please choose one

A computer program that facilitates the communication between the computer and a peripheral device
is called___ Language Translator

» Operating system » Utilities » Language Translator _ » Device Drives

Question No: 24 ( Marks: 1) - Please choose one
In JavaScript, what will be the result of the following operation 79%3
»0 » 1 » 2 » 3

Question No: 25 ( Marks: 1) - Please choose one
Which of the following number system is used by microprocessor? Binary
» Binary » Decimal » Octal » Hexadecimal

Question No: 26 ( Marks: 1) - Please choose one
Web site is collection of related ____ Information____
» Web pages P Information P Search Engines B None of the given choices
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